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Introduction:

	This spreadsheet predicts the number of pigs weaned per week based on the number of sows bred per week, farrowing rate, pigs born alive, and preweaning mortality.  The spreadsheet begins in July of last year.  Twelve week rolling averages of historical and current information are used to calculate the predictions.   Predictions are updated on a weekly basis using the most current data available.

	The spreadsheet has thirteen different pages:  the first page is for data entry, and each of the other twelve represents predictions for breedings during each month.  



Getting Data from PigCHAMP:



User Defined Performance Monitors:



1.	Open PigCHAMP program and select your farm.



2.	Use the arrow keys to highlight "Setup" in the Base Menu.     Press ENTER.



3.	Highlight "Farm Details" in the Setup menu.  Press ENTER.



4.	Highlight "User Defined Reports" in the Farm Details menu.  Press ENTER.



5.	A cursor should appear on the right side of the screen after "Report to edit."  Type "PERFORMANCE MONITOR", if it is not already listed.  Press ENTER.  Press INSERT.



6.	Choose each of the following variables from the list on the screen under the FARROWING PERFORMANCE title.  Use the arrow keys to scroll through the list.



		ï Served to farrow this period

		ï Farrowing rate

		ï Sows farrowed and weaned

		ï Pigs weaned per sow farrowed

		ï PWM for farrowed and weaned

		ï Born for farrowed and weaned

		ï Weaned for farrowed and weaned



To choose these variables, use the arrow keys to move the cursor to the left side of the variable.  Press Y for yes.  Press ENTER.  When all variables have been selected a "YES" will be printed to the right of each of the variable names listed above.  Once this is done, press INSERT.



Save 48 weeks of Farrowing Data:



7.	Press ESC ESC ESC.  This should return you to the Base Menu.



8.	At the Base Menu, highlight "Reports."  Press ENTER.



9.	In the Reports menu, highlight "Breeding Herd Reports."  Press ENTER.



10.	In the Breeding Herd Reports menu, highlight "Performance Monitor."  Press ENTER.



11.	To set up performance monitor:

	    	Enter last day of report in the form DDMMMYY.  When  		beginning the program, choose as the last day of report 		the third Sunday in September of the previous year.  



To run the program:	for 1995 breedings, enter 18SEP94

						for 1996 breedings, enter 17SEP95

						for 1997 breedings, enter 15SEP96 



	You will need weekly Performance Monitors in the “user 	defined format” starting with the third Sunday in September 	of the year previous to the year in which you are 	 	interested.  Weeks 	will start with Monday and end on 	 	Sunday.  Therefore, always use Sunday as your last day  	when printing out reports on Farrowing Information.  

	After date has been typed in, 	press ENTER.



		Type 12 in the row labeled "Number of periods in the  		report."  Press ENTER.



		Type W in the row "Length of each period."  

		Press ENTER.  "1 WEEK" should appear.



		

		Type NONE in row "Rolling average increment."  

		Press ENTER.

	

		Type NONE in row "Summary column."  Press ENTER.



		Type NONE in row "Parity distribution."  Press ENTER.



		Type 0 in row "Number of diskettes."  Press ENTER.



		Type U for User Reports in row "Report Format."  

		Press ENTER.

	

		Type NONE in row "...target values...."  Press ENTER.



		Type L for Lotus file in row "Output device."  

		Press ENTER. Type c:\qpro\farrow1 then press enter  		(PigCHAMP will add the extension for the file)



		Type 1 in row "Number of copies."  Press ENTER.



		Press insert to generate the file.



The PERFORMANCE MONITOR will look like this:  now press INSERT. 



Last day of report�18 SEP  94��Number of periods in report�12��Length of each period�1 WEEK��Rolling average increment�NONE��Summary column�NONE��Parity distribution�NONE��Number of archive diskettes to include�NONE��Report format�USER��Do you want target values printed on the report?�NO��Output device�c:\qpro\farrow1.wks��Number of copies to print�1��

12.	Continue to generate PERFORMANCE MONITORS for every 12 week period up to the week in which you have the most current breeding information.  Change the name of the Lotus file for each report to avoid overwriting a report.  Use a different name for each file (ie farrrow1.wks; farrow2.wks; farrow3.wks; farrow4.wks) The 12 week ending dates for 1995 breedings are 18SEP94, 07DEC94, 01MAR95, and 24MAY95.



13.	After generating all of the necessary farrowing PERFORMANCE MONITORS, press ESC ESC ESC to return to Base Menu.



Save 48 weeks of Breeding Data:



14.	PERFORMANCE MONITORS must also be printed for service information.  Only one variable is needed in these monitors.  To do this:

		a) repeat steps 1-5.



		b) in the BREEDING PERFORMANCE variable list, select "Total number of services."  To choose the variable, use the arrow keys to move the cursor to the left side of the variable.  Press Y for yes.  Press ENTER. If the variables used previously are still selected, press N ENTER to un-select them.  Press INSERT.



		c) repeat steps 8-10.   



		d) set up PERFORMANCE MONITOR in the same way as before, except choose the third Thursday in September for last day of report. 



To run the program:	for 1995 breedings, enter 22SEP94

						for 1996 breedings, enter 21SEP95

						for 1997 breedings, enter 19SEP96   



	e)	Continue to generate 12 week service PERFORMANCE MONITORS up to the week in which you have the most current breeding information. As before, use a new name for each breeding report file you create.  The 12 week ending dates for 1995 breedings are 22SEP94, 11DEC94, 05MAR95, and 28MAY95.



15.	After all necessary printouts have been obtained, press ESC ESC ESC ESC which should return you to the c:\ dos prompt.



Opening the Spreadsheet:



1.	Enter the Quattro Pro program.



2.	Highlight "File" in the menu bar at the top of the screen by clicking on it once with the mouse or by pressing /.  Press ENTER.



3.	Use the arrow keys to highlight "Open."  Press ENTER.



4.	An "Open File" box should be on the screen.  Choose the file capacity.wq2 from the c:\ drive directory by using the arrow keys to highlight it and then pressing ENTER.  If you are using a disk copy of the spreadsheet, use the mouse to click the "DRV" button in the upper right corner of the "Open File" box.  Choose the drive (either a:\ or b:\) that your disk is in.  Press ENTER.  Now select the file capacity.wq2 from the drive directory.



5.	The spreadsheet should be open on your screen.



�6.	At the bottom of the screen are labeled tabs.  These are used to switch pages in the spreadsheet.  Use the mouse and click once on the tab labeled "Data," or press Ctrl-PgUp until the "Data" tab is highlighted.  This page is the only page you will alter while using the spreadsheet.



7.	Press the HOME key to go to the top of the spreadsheet.  Use the arrow keys or the mouse to highlight cell B5.  



8.	Enter the beginning date for the spreadsheet as the first Monday in July between July 3 and July 9 of the year prior to the year you are primarily interested in. 

To run the program:	for 1995 breedings, enter 04JUL94

						for 1996 breedings, enter 03JUL95

						for 1997 breedings, enter 08JUL96



To enter this date, first press Ctrl-D (in Qpro for windows use Ctrl-Shift-D).  Now enter the date in the form MM/DD/YY.  In the previous example, this would be entered as "07/04/94."  Press ENTER.  All other dates will change automatically.  



	NOTE: If you do not have data for the previous year, leave  		all columns of the spread sheet empty until you have  		data available.  The spreadsheet predictions are based 		on 12 week rolling averages.  As you accumulate more 		data, the predictions will become more accurate.



Entering Data by Hand



9a.	Enter the data from the farrowing PERFORMANCE MONITORS onto the spreadsheet beginning on row 6.  Begin entering the information for the first Monday in July or for the first column for which you have information.  The first day of every week as printed on the PERFORMANCE MONITOR should correspond exactly with the dates in the top row of the spreadsheet.  If the first week on the PERFORMANCE MONITOR begins in June then ignore this column.  Also, the variables printed on the PERFORMANCE MONITOR should correspond with those in the first column of the spreadsheet.  If either the dates or the variables do not correspond, stop now.  Check the date you entered in cell B6 or the PERFORMANCE MONITOR before continuing.



�Entering Data Automatically



To copy the data from the PigCHAMP output file to the spread sheet do the following:



9b. While you have the capacity spreadsheet open on the screen,  	highlight “FILE” in the menu bar at the top of the screen by 	clicking on it once with the mouse or by pressing /.  Press  	enter



9c. 	Use the arrow keys to highlight “Open”.  Press enter



9d. 	An “open file” box will be on the screen.  Choose the file  	farrow1.wks from the c:\qpro directory by using the arrow  	kesy to highlight it and then press enter.



9e. 	The first Performance Monitor report should be open on your  	screen.



9f. 	Block the cells with all of the data. Use the arrow keys to  	highlight the first cell that will go into the Capacity.wq2  	spread sheet.  If the first date in column B is in June, 	begin with cell C11.  If the first date in column B is in 	July, begin with cell B11.



9g. 	Click on “Edit” with the mouse and press enter or press /,  	then E to use the Edit menu.  Highlight “Copy Special” and  	press enter or press O.  Press enter to copy contents.  To  	highlight block of cells top copy, press end then the right  	arrow key, then end and the down arrow key.  This will  	highlight the numbers only and not any dates or row titles.  	Press enter.  When prompted for destination for cells, press 	alt-0 then highlight ‘capacity.wq2” and press enter.  When  	the capacity worksheet is on the screen, move the highlight 	to cell B6 and press enter.  Be sure the date in cell B6  	matches the first date in the column in which you begin 	copying from the farrow spreadsheet.



9h.	When the data from the first 12 weeks is copied, close the first performance monitor output, and open the second output file (farrow2.wks).  Repeat the blocking and copying directions until all farrowing information has been transfered to the capacity spreadsheet. 



9i.	Enter all information currently available.  Save your work by pressing Ctrl-S or by clicking "File" and and clicking  on "Save."  



9j. Repeat steps 3 to 11 with the breeding report files.  Enter 	the data from these reports in the bottom section of the  	capacity spreadsheet under Total Number of Services.



10. Save the file by pressing Ctrl-S or clicking “File” and  	“Save”.





You can now view the weekly predictions.



1.	Use the mouse or press Ctrl-PgDn to highlight the tab for the service month of interest.



2.	Use the arrow keys to move across row 5 to the date of the current week.



3.	Use the arrow keys to move down this column to rows 17 and 18.  The numbers in these two cells are predictions for the number of pigs which will be weaned from one week's worth of breedings that took place during the month displayed.



4.	The two bottom rows show differences between the actual number weaned and the predictions.  Once actual weaning information has been entered (this information will be located in columns Z..AD of the monthly pages), these two values will give you an idea of how well the spreadsheet is predicting for your farm.





Viewing the Graphs



5.	To view the prediction information graphically, highlight "Graph" in the top menu bar by using the mouse or pressing / and g.  Press ENTER.  Use the arrow keys to highlight "Name" and press ENTER.  Now choose "Display" and press ENTER.  



6.	A list of graphs for this spreadsheet should now be open.  

		a) Choose a monthly prediction spreadsheet ("Jan. Pred." through "Dec. Pred.") to view the fluctuating weaning predictions for a particular month's breedings.  

		b) Choose "Weaned Per Week" to view the fluctuation in the actual number of pigs weaned/week for your herd over the course of the year.



c) Choose "# Services", "Farrowing Rate", "Born Alive", or "PWM" to see how the number of pigs weaned per week fluctuates with weekly changes in the number of sows served, farrowing rate, the number of pigs born alive, and the survival rate of live born pigs (100-PWM) respectively.



7.	After you have finished looking over the spreadsheet, save it one more time.  Then, go to the "File" menu in the menu bar, and click twice on "Exit" with your mouse or use the arrow keys to select "Exit" and press ENTER.  



8.	You have completed this use of the spreadsheet, and you can use it as often as you wish to update herd information and get new weaning predictions.





To Update the Spreadsheet:



	After the farm's historical data has been entered, it is easy to update the spreadsheet on a regular basis.  The spreadsheet may be updated as soon as new service, farrowing, or weaning information is available to the user.



1.	To update farrowing information when it becomes available, follow the instructions listed previously for printing farrowing performance monitors from PigCHAMP.  Remember to use weeks ending with Sunday.  Enter the new information into the spreadsheet in the correct date columns and variable rows on the DATA page.



2.	To update service information:	

a)  Follow the previously listed instructions for printing service PERFORMANCE MONITORS as information becomes available in PigCHAMP.  Remember to use weeks ending with Thursday.  Enter this new information into the spreadsheet in the correct cell on the DATA page. 

	

	 OR



		b)  Enter the number of sows served per week without taking it from PigCHAMP if you already know this information. 



As you continue to use the spreadsheet, information can be added to the program as current breeding, farrowing, and weaning information becomes available.  For herds beginning in July, a one-year's cycle is completed after sows bred in December have farrowed and weaned, and both service and farrowing data have been entered through this date.





Continuing to Use the Spreadsheet



	After gaining some experience with the spreadsheet, you may want to continue using it for more years or you may want to use it for a different farm.  To do either of these things, you must first create a new copy of the spreadsheet.



To do this:

1.  	Highlight "File" in the menu bar and press ENTER.



2.  	Highlight "Save As" and press ENTER.



3.  	You should receive a prompt to name the saved copy.  Type in  the name of your new copy.  Press ENTER.



4. 	The new copy will now be open on the screen.  To use the old copy now, go to the "File" menu and choose "Open."  Then choose the name of the old copy and press ENTER.  You may have to close the new copy before openning the old one on some computers.



If you plan to use the new copy for a different farm, you must first clear the screen before entering new information.  To do this:



5.	Be sure the new copy of the spreadsheet is open on the screen.  (Open it if you had previously closed it.)



6.  	Go to cell B6.



7.  	Highlight "Tools" in the menu bar and press ENTER.



8.  	Highlight "Macro" and press ENTER.



9.	Highlight "Execute" and press ENTER.



10.  At the prompt, press F3.



11.  Choose "clear all" from the list of macros.  Press ENTER.  



12.	You should now be prompted to enter the block of cells you want to modify.  This should read "Data:B6..B6."  If so, press ENTER.



13. 	The macro should run and delete the previous data from your screen.  



If you want to use your new copy to continue the original spreadsheet into the next consecutive year, do the following:



14.	Open the new spreadsheet (if it is not already open) and be sure that it is visable on the screen.



15.  Go to cell BB6.



16.  Follow steps 7-10 as listed above.



17.	Choose "New Yr. Restart" from the macro list.  Press ENTER.  This macro will adjust the information that you entered for the first year to become historical information for the second year, and will erase all unnecessary data so that you can begin entering new data.  



18.	You will now be prompted to enter the block of cells to be modified.  It should read "Data:BB6..BB6."  If so, press ENTER.



19.  The macro will now make the necessary adjustments.  



20.	To use the spreadsheet for the new year, you must first change the date in cell B5 as instructed previously.



21.	You can now obtain the necessary performance monitors and enter data as before beginning in cell AB6.



22.	Data will also have to be updated in the original spreadsheet if you want to continue using it for that particular year.  







�Key Columns



B:		First column of values



J: 		The actual service information is available.



Z-AD:	All information is actual.









FORMULAS (for monthly pages Jan.-Dec.)



Row	Title					Formula



5	Total number of services 	

For B-I, "total # of services" 8-wks. prior to the column date.  For J-AD, a 3-wk. rolling average of 7 weeks of services beginning 1 wk. before the actual services for the month.

6	Served to farrow			

"Served to farrow this period" 8-wks. prior to the column date.

7	Sows farrowed & weaned(act.)	

"Sows farrowed and weaned" 8-wks. prior to the column date.

8	Sows far. & wean.(rolling avg	

A rolling average which includes the row 7 value and the values for eleven weeks prior to it.  At Z, it changes to the row 7 value.

9	Farrowing rate (actual)		

"Farrowing rate" 8-wks. prior to the column date. 

10 	Farrowing rate(rolling avg.)	

A rolling average which includes the row 9 value and the values for 11 wks. prior to it.  At Z, it changes to the row 9 value.

�11	Pigs born alive/litter (act.)	

"Born for farrowed and weaned"/"Sows farrowed and weaned" 8-wks. prior to the column date.

12	Pigs BA/litter (rolling avg.)	

A rolling average including the row 11 value and the values for 11-wks. prior to it.  At Z, it changes to the row 11 value.

13	Pigs weaned per sow farrowed (act)	

"Pigs weaned per sow farrowed" 8-wks. prior to the column date.

14	Pigs weaned/sow farrowed (roll. avg.)

A rolling average which includes the row 13 value and the values for 11 wks. prior to it.  At Z, it switches to the row 13 value.

15	PWM for farrowed & weaned (act.)

"PWM for farr. & wean." 8-wks prior to the column date.

16	PWM for farr. & wean.(roll. avg.)

							A rolling average which includes the row 15 value and the values for 11 wks. prior to it.  At Z, it changes to the row 15 value.

17	Prediction 1	

Pigs BA/litter * (100-PWM for farr. and wean.)/100 * Sows farrowed and weaned.

18	Prediction 2

For B-I:

Sows farr. & wean./Pigs weaned per sow farrowed.

For J->:

Total number of services* Farrowing rate*Pigs weaned per sow farrowed.

�19	Actual pigs weaned			

The 5 actual values for the number of pigs weaned from a particular month of breedings are found in columns Z-AD.  These five numbers are repeated back to the beginning.

20	Actual pigs weaned (average)	

The mean of the 5 values from row 19 Z-AD.

21 	Difference (act. - Pred.1)

For B-Y:

Actual pigs weaned (avg.) - Prediction 1

For Z->:

Actual pigs weaned - Prediction 1

22	Difference (act. - Pred. 2)	

For B-I:

Actual pigs weaned (avg.) - Prediction 2

For J->:

Actual pigs weaned - Prediction 2		
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